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Currently I need to highlight certain sections in PDFs, or add annotations (comments/notes). These modifications would need to be saved. 


What tools are out there to do this on Ubuntu?
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                Have you looked at PDF edit from USC?
                
                
– Mitch
                

                May 23, 2012 at 16:54
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                Have just tried pdfedit, ugly gui, no highlighting tools. It is not what i wanted. (if you are sure, give me instructions about how to do that with that pdfedit)
                
                
– Anwar
                

                May 23, 2012 at 18:03
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                I tried it, too. It has such tools in the toolbar above the text, but it didn't work as expected: When I tried to highlight text in a pdf I made with LibreOffice the area above the text became highlighted ... But than saving it the highlighting also is visible with Evince for example, although at the wrong place. → Not really a solution.
                
                
– Jakob
                

                May 23, 2012 at 18:09
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                Google docs. I know it sounds like a cop-out at first, but it works and it will definitely be cross-platform. You can even download the result as a PDF containing the annotations you made
                
                
– cxrodgers
                

                Jun 25, 2013 at 10:07
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                ** UPDATE **: Native Foxit Reader now enables highlighting foxitsoftware.com/downloads
                
                
– Orion
                

                Dec 7, 2015 at 15:12
                        
                            
                        
            

        

    


	    


        
                    
                 | 
            Show 3 more comments
        
         
    

    







                
                
                
                    
                    
                        
                            
                                
                                        26 Answers
                                    26
                                

                            

                            
                                


    
        
            Sorted by:
        
        
            Reset to default
        
    

    
        
                        Highest score (default)
                    

                        Date modified (newest first)
                    

                        Date created (oldest first)
                    


    





                            

                        

                    



                                    


    
        
            
        
            
        
        
            203
        

        
            
        


        

    
    








            
                
                    
                

            


    
    




        


        


    
    
Okular supports PDF annotations.

To save the highlighting/annotations directly in the PDF document, choose File > Save as... and create a new PDF which will contain your edits.

How to edit in Okular

You can choose Tools > Reviews to get other options like adding

	pop-up notes
	inline notes
	freehand line drawing
	highlighter
	stamp




Edit: Inkscape supports PDF editing (one page at a time) and most people seem not to be aware of this so I'm adding it to the answer.
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                Okular stores annotations and highlights outside of the edited document (it seems to be a Poppler limitation!) okular.kde.org/faq.php#addedannotationsinpdf This means that changes are only visible from Okular, on the machine they were created.
                
                
– MarkovCh1
                

                Aug 22, 2011 at 23:10
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                Well actually Inkscape is only able to import pdfs one page at a time and then you can edit the pdf. Annotation would not require any editing of the items in the pdf.
                
                
– To Do
                

                Jan 28, 2012 at 20:47
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                Inkscape allowed me to highlight text as well as 'redact' some personal information from a PDF by drawing opaque boxes over the text.  Excellent solution, took ~30 seconds to install, about the same amount of time to edit my one page PDF.  Thanks Li Lo!
                
                
– OpensourceFool
                

                Jan 6, 2013 at 22:48
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                Okular can now save annotations to PDFs, see askubuntu.com/questions/1529/how-can-i-highlight-pdfs/…
                
                
– Thomas Arildsen
                

                May 14, 2013 at 9:29
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                @OpensourceFool Drawing opaque boxes over the text does not remove it, it only hides it and your box can easily be removed to reveal the text underneath (assuming you are saving to the PDF format). More about that here: apple.stackexchange.com/questions/22683/…
                
                
– erb
                

                Nov 25, 2015 at 11:53
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Recently a new version of Foxit Reader is released for Linux. It has the highlighting and annotating support. It has more annotation options than Okular, including inline notes with transparent background, drawing of various shapes etc.


How to install Foxit Reader in Ubuntu is explained in this AskUbuntu answer:
 Install FoxitReader
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                Great! It is fast, lots of options, saves everything to a single file, thus suitable for annotation. After downloading, make sure the .run file is executable. Also, you might wanted to edit mime types ~/.local/share/applications/mimeapps.list after installation.
                
                
– VRR
                

                Oct 24, 2015 at 15:42
            

        

    
	
        
            
            

        

        
            
                
                can you add more steps how to install this? I can't find it after installation.
                
                
– an offer can't refuse
                

                Jan 13, 2016 at 2:16
            

        

    
	
        
            
            

        

        
            
                
                Please check this answer. It provides the necessary steps to install the software. askubuntu.com/a/679213/421047
                
                
– Gobinath
                

                Jan 13, 2016 at 4:38
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                This should be upvoted more. The new version works quite well, with much more annotation options than Okular.
                
                
– xji
                

                May 1, 2016 at 5:26
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                Foxit unfortunately doesn't work well on 4K displays and annotation in Linux seems half done.
                
                
– Shital Shah
                

                Dec 12, 2019 at 2:16
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Actually, none of these solutions work half as well as anything on Windows or Mac OS. 
Mendeley only supports yellow highlighting and importing pdfs into Inkscape or OpenOffice is pretty inconvenient if you want to read a paper and simply make some annotations. 


Fortunately, there are some free pdf viewers for Windows that work flawlessly with wine (If you find wine too complicated, use PlayOnLinux - a great front end for wine configuration). One of the best of those viewers is the PDF-XChange Viewer by Tracker Software. There is a free version that comes with a ton of annotation features, session saving etc. Grab it here:


http://www.tracker-software.com/product/downloads


And check out this screenshot:





I really wish there was a working open source Linux alternative (xournal is good but too limited). But for the time being, I am happy with using wine.
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                I'm sure Inkscape, pdfedit, or okular work at least half as well as some packages on MacOS or Windows.
                
                
– belacqua
                

                Mar 20, 2011 at 22:27
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                +1: This is, so far, the only good option. It works great in Wine, mod some Unity-specific bugs that are getting fixed, and supports a wide collection of document markup options.
                
                
– MarkovCh1
                

                Aug 22, 2011 at 23:08
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                I normally use Foxit_PDF_Editor on Wine
                
                
– blvdeer
                

                Jan 11, 2013 at 18:44
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                Okular can now store the annotations in the pdf itself
                
                
– Hashken
                

                Nov 12, 2013 at 23:16
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                @Sadi: I have found the portable versions of PDF-XChange Viewer to work well with any WINE version I tested it (including 1.7.8 x64). So that's an option as well. And although your statement is true, it won't help if you have several modified but unsaved documents opened.
                
                
– onse
                

                Dec 10, 2013 at 21:26
            

        

    


	    


        
                    
                 | 
            Show 8 more comments
        
         
    

    





    

		



                                    


    
        
            
        
            
        
        
            52
        

        
            
        


        

    
    








            
                
                    
                

            


    
    




        


        


    
    
xournal is also some software which you use for this task.

screenshot of xournal from 2022:
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                xournal only saves the highlights in a xournal-specific format (basically converts the PDF to images, and highlights there)
                
                
– MarkovCh1
                

                Aug 22, 2011 at 22:10
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                I just used Xournal for annotating a PDF file, and exported the annotated version to PDF, and it worked perfectly.
                
                
– Erel Segal-Halevi
                

                Mar 20, 2013 at 10:28
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                @ErelSegalHalevi Please disregard my last comment. Recent revisions of Xournal do not rasterize the PDF. Both text and scalable vector elements are preserved. This make Xournal the best choice for PDF annotation by far.
                
                
– Glutanimate
                

                Apr 21, 2013 at 19:22
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                One of the nicest little features in xournal is that you can use pressure-sensitive pen input, and even these scribbled annotations will be saved as vector graphics, not images. Means, small file size all around.
                
                
– tanius
                

                Oct 28, 2015 at 11:36
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                WOW what a hidden gem! It is an amazing application. Lightweight, user friendly with functionality you don't find in other pdf programs.
                
                
– apanagio
                

                Apr 29, 2020 at 15:02
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Future version of Evince will support PDF annotation and highlight.
Here you can see a video of the first partial implementation, made by Carlos Garcia Campos 


If you want to try I think you need to have at least evince 2.32 and recompile yourself latest version of Poppler cloning from the git repository:


git clone git://git.freedesktop.org/git/poppler/poppler



Here the launchpad bug of this missing feature from evince (poppler packaged for Maverick isn't enough updated).


21 april 2011 - Update
Evince in Natty now support by default annotations (not highlighting).
Evince in Natty is 2.32, poppler is 0.16.4.


08 March 2017 Update Evince in Ubuntu 16.04 supports highlighting.
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                I have 12.04, evince 3.4.0, poppler 0.18.4, and I can't find the annotation feature in the menus...
                
                
– Erel Segal-Halevi
                

                Mar 20, 2013 at 9:29
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                It can be do in the side pane now. (I have not tried with 12.04.) help.gnome.org/users/evince/stable/annotations.html.en
                
                
– Arpad Horvath
                

                Jul 29, 2014 at 6:26
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                It's not really highlighting but more adding notes to the documents
                
                
– shaneonabike
                

                Sep 20, 2014 at 20:43
            

        

    
	
        
            
            

        

        
            
                
                Indeed, in 14.04 you can also access Annotations in the side-pane, and add comments/notes. You can then save a copy, and it shall be compatible with Adobe Reader. A bitten hidden from the user, but nifty stuff.
                
                
– landroni
                

                Jan 24, 2015 at 18:36
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                Evince supports highlighting, annotating and saving to pdf after upgrade to 16.04. Yay!
                
                
– Valentas
                

                Aug 4, 2016 at 12:35
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The  evince package which is built-in in Ubuntu and is called Document Viewer can add annotations to PDFs.

Evince 3.18.2 from the Ubuntu 16.04 default repositories has support for highlight annotations and moving annotation icons to a different position on the page.

If you do not have a visible side pane on the left side of the opened document's window, click View -> Side Pane or press F9 to make the side pane visible. At the top of this side pane, there is a dropdown menu with options like Thumbnails, Index and Annotations (some of which may be dimmed for some documents).

To create an annotation

	Select Annotations from the dropdown menu. You should now see List and Add tabs under the dropdown menu.



In Ubuntu 16.04 and later, click the toolbar icon that looks like a notepad. A new toolbar will appear under the toolbar with two icons for adding text annotations and  adding highlight annotations.






	Select the Add tab.


	Click on the icon to add an annotation.



In Ubuntu 16.04 and later, the icon for adding a text annotation looks like  piece of paper with a + in the upper right corner (marked by a diagonal yellow arrow in the below screenshot), and the icon for adding a highlight annotation looks like a piece of paper with three black blocks on it.






	Click on the spot in the document window you would like to add the annotation to, preferably a blank spot where the annotation will not cover anything else in the document. Your annotation window will open.


	Type your text into the annotation window. You can resize the note by clicking and holding the left mouse button on one of the bottom corners of the note, and moving it around.


	Close the note by clicking on the x in the top corner of the note. You might need to hover over the x with the mouse to make it visible.


	When you want to go an annotation click on the icon for it. If you can't see the annotation icons, then unfold the little black arrows to the left of the page numbers in the side pane to show them. The text annotation icon looks like a piece of paper with a pencil over it in Ubuntu 14.04 and it looks like a pencil in Ubuntu 16.04. The highlight annotation icon looks like a piece of paper in Ubuntu 16.04.


	When you close the document you will be asked if you want to save the changes you made to it.




To create a highlight

The evince snap package makes the highlight text feature available to all currently supported versions of Ubuntu, otherwise the evince apt package in 18.04 and later also has the highlight text feature.

	Click the pencil icon in the upper left corner. In some versions of Evince there is a small notebook icon instead of a pencil icon in the upper left corner.


	Click the Highlight text button in the upper left corner.


	Select some text with the mouse and it will be highlighted.


	When you close the document you will be asked if you want to save the changes you made to it.




The highlight feature of evince can also be obtained in Ubuntu 16.04 by installing the evince snap package:

sudo snap install evince  
sudo snap install gnome-3-28-1804  
sudo snap connect evince:gnome-3-28-1804 gnome-3-28-1804


    

    
        
            
            
                




    

        
            Share
        



                    
                        Improve this answer
                    


                
                    
                        Follow
                    
                







    

    



            

            

    
        
            edited Oct 8, 2020 at 13:24
        

        
    

    
        
    

    
        
        
            
        

    



            



            
                
    
        
            answered Aug 29, 2015 at 5:15
        

        
    

    
        

    

    
        karelkarel
        
            114k110110 gold badges279279 silver badges310310 bronze badges
        

    





            

        

        
    
    

    






            5 
    
        
            	
        
            
                    1
            

        

        
            
                
                I use evince for many years, just found out this button today.
                
                
– Eduardo Santana
                

                Mar 11, 2017 at 15:58
            

        

    
	
        
            
            

        

        
            
                
                but how you will highlight things? Also, is there a way to see the notes alongside pdf in the viewer? You can do that in Mendeley!
                
                
– Anu
                

                Jan 13, 2019 at 15:30
            

        

    
	
        
            
            

        

        
            
                
                The highlight feature will not be available in evince from the default Ubuntu 19.04 repositories. When evince 3.31 or later lands in the default Ubuntu repositories, I will add the instructions for using its highlight feature to my answer.
                
                
– karel
                

                Jan 13, 2019 at 15:37
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                Evince works great for my annotation needs on Ubuntu 18, has dark mode (inverted colors) and is built-in. Foxit Reader on the other hand is half done and not even usable on 4K displays.
                
                
– Shital Shah
                

                Dec 12, 2019 at 6:52
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                In April 2021, evince still has only "save as" and not save. Which means you systematically get a file chooser to open and then an overwrite warning. This tiny annoyance rapidly gets irritating as I save after every annotation (sadly, Ubuntu crashes often).
                
                
– Arnaud
                

                Apr 18, 2021 at 19:28
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-------------- EDIT March 2018 --------------


Having used multiple pdf viewers editors, and after 6 years (!) of asking this question, I settled in two different tools for different purposes:


	Mendeley Desktop is an excellent reference managers and it works flawlessly in most Ubuntu versions. It is ideal for papers and academic writing and supports notes and highlights synchronization. 

	Evince (or Document Viewer), the default pdf viewer as of Ubuntu 18.04 also supports highlighting and annotations. To show the annotations menu bar, you must click on the red circle (see below). The annotation options appear and you can annotate or highlight as seen in the blue circle in the image below. 







--------------------------------------------------------


For me the best solution was PDF X-Change Viewer. 



  It just installs and works flawlessly under Wine. (Source)




The only issue is that sometimes when you scroll fast it shows some white spaces over the text, that clear when you click or select a line in the document. 


There is an option in the Edit menu under Preferences\Performance\Threads Usage:
"Use synchronous mode of page rendering"
which prevents those white spaces in mine.
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                Yes, PDF X-Change with Wine is the best solution, but that is what user11305 had already replied.
                
                
– mivk
                

                Jun 1, 2015 at 9:52
            

        

    
	
        
            
                    1
            

        

        
            
                
                PDF-XChange Editor still in 2020 working flawlessly in Wine 5.2. Tested and used every day under Ubuntu 18.04 and PDF-XChange Editor v8.0 b335.
                
                
– f0nzie
                

                Feb 26, 2020 at 15:59
            

        

    
	
        
            
            

        

        
            
                
                In April 2021, evince still has only "save as" and not save. Which means you systematically get a file chooser to open and then an overwrite warning. This tiny annoyance rapidly gets irritating as I save after every annotation (sadly, Ubuntu crashes often).
                
                
– Arnaud
                

                Apr 18, 2021 at 19:25
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There is a package called pdfedit that can do this.
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                Note that pdfedit has been dropped from Ubuntu as of 12.10
                
                
– Dustin Kirkland
                

                Dec 17, 2012 at 22:22
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                Also, on 12.04 there are some errors, such as, when trying to change the color or font. Also, pdfedit has no undo, which can be very frustrating, especially since the highlighing does not work as expected (highlights a full line instead of a single word).
                
                
– Erel Segal-Halevi
                

                Mar 20, 2013 at 9:27
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The PDF viewer in Mendeley allows you to highlight and annotate PDFs. To save the modifications you need to File > Export PDF with Annotations.


However Mendeley is not open-source, and it forces you to use an account... But otherwise the functionality is excellent.


You can download from here.
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                While Mendelay has a nice interface, the annotation abilities are limited (can only add sticky notes; no drawing or text boxes), and annotations and highlighting aren't saved in the document.
                
                
– MarkovCh1
                

                Aug 22, 2011 at 23:06
            

        

    
	
        
            
            

        

        
            
                
                @MarkovCh1 In my experience they are, if you Export PDF with annotations.
                
                
– landroni
                

                Jan 24, 2015 at 18:38
            

        

    
	
        
            
            

        

        
            
                
                What I love about Mendeley is its ability to export a page in the end of the PDF, listing all the annotations. Pretty cool. I hate though that it's not open-source, and that it forces you to use an account...
                
                
– landroni
                

                Jan 24, 2015 at 23:42
            

        

    
	
        
            
            

        

        
            
                
                Mendeley does not currently support adding/deleting bookmarks
                
                
– titus
                

                Nov 14, 2015 at 16:15
            

        

    
	
        
            
            

        

        
            
                
                I like Mendeley too. Despite its limitations, the fact that it can sync changes is incredibly useful. You can highlight/add sticky notes using the desktop application, Android or iOS app, and also from the Mendeley website. However, as others have noted, you have to look elsewhere if you need to do anything other than highlight or add sticky notes
                
                
– Hee Jin
                

                May 2, 2018 at 23:20
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Now you can actually export annotations to PDFs in Okular (this was not possible until recently): http://docs.kde.org/stable/en/kdegraphics/okular/annotations.html


It seems Okular has to be built with Poppler at least version 0.20. It works with Ubuntu 13.04.
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There's a plugin for OpenOffice.org that does this.


http://extensions.services.openoffice.org/project/pdfimport
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Xournal++ has not been suggested yet. It allows to use a PDF document as a background to draw and put text objects and even LaTeXed formulas on top.



Xournal++ does not modify the background PDF document, but stores all drawings in a separate file. It is possible to export the combined result as a single PDF.

Xournal++ does not allow to select text or other objects in the background PDF, but it can be used in conjunction with Evince or Okular, where Evince or Okular is used to highlight or underline text in the underlying PDF, and Xournal++ is used to draw on top. However, the are issues with printing or "flattening" certain annotations created in Evince and in Okular.
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                Add some installation instruction, and possibly a screenshot
                
                
– Archisman Panigrahi
                

                Oct 31, 2020 at 14:41
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                this is the best in here by 2022
                
                
– imbr
                

                Sep 16, 2022 at 12:58
            

        

    
	
        
            
            

        

        
            
                
                By September 2022, Xournal++ allows to select text from the background PDF, and copy or highlight it. Source: I installed it yesterday and it can do that.
                
                
– user171780
                

                Sep 17, 2022 at 10:09
            

        

    
	
        
            
            

        

        
            
                
                @user171780, could you specify the version and the tool used to select text, please? I could not do it in version 1.1.1.
                
                
– Alexey
                

                Sep 17, 2022 at 18:31
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                @Alexey it is version 1.1.1+dev, built on Feb 12 2022, 10:39:46. The tool can be found in Tools → Select linear text. I wasn't aware I have the development version, maybe it will soon be available in the regular version too.
                
                
– user171780
                

                Sep 18, 2022 at 8:04
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Master PDF Editor is a good software for annotating PDFs. There is a free version for non-commercial use.


Features:


	Adding images to PDF 
	Adding/editing bookmarks
	Opening PDFs in tabs
	Adding sticky notes to PDFs
	Adding Ellipse, Rectangle, Lines
	Highlighting, striking out, underlining texts



I think it works just like Foxit reader for windows.
Advantages over okular: 


	In Master PDF Editor you can save PDF in a normal way without the need to saving PDF using "save as".
	In okular as far as I know you can't add or edit bookmarks but in Master PDF Editor you can easily do that.
	In okular you can't add images to pdf, But in Master PDF Editor you can.



Disadvantage over okular: 

It uses too much RAM.
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                +1 but if others are interested in this, the commenting functions are much less powerful than, say, Foxit or PDF-XChange Viewer. It's very powerful in other ways (e.g. editing the pdf itself), but not as saving comments per se. You can add shapes and text directly to the pdf, but these won't save as the comment layer. Changing the format of the highlights, etc. is also very fiddly (need to open up setting every time).
                
                
– Sparhawk
                

                Apr 18, 2016 at 12:48
            

        

    
	
        
            
            

        

        
            
                
                Great tool, worked with a LaTeX PDF that LibreOffice Draw, Xournal, etc. would not handle correctly
                
                
– qwr
                

                Jan 30, 2017 at 6:03
            

        

    
	
        
            
            

        

        
            
                
                btw version 4 is more capable than version 5 which also has an ugly watermark. see linuxuprising.com/2019/04/…
                
                
– qwr
                

                Mar 2, 2021 at 7:26
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I was searching for exactly the same. For me, qpdfview works like a charm, is simple to use and lightweight. Its annotations and text highlighting is recognised in Adobe Reader (Linux version 9, Windows. iOS). Editing done on the aforementioned platforms are recognised by qpdfview as well. It allows you to delete annotations and highlighting too, and stores annotations in the PDF.


It is free, the source code can be found on launchpad. You find it in the Ubuntu Software Center and there is a ppa for a more recent version: ppa:b-eltzner/qpdfview
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                In qpdfview 0.4.16, annotations can be created using CTRL+a. Then, one creates a rectangle and chooses "Add text" or "Add highlight". This is very different from Acrobat Professional 8.1, where I can select text and then choose whether I want to add a comment, delete the text, add text or replace the text.
                
                
– koppor
                

                May 8, 2016 at 14:06
                        
                            
                        
            

        

    
	
        
            
            

        

        
            
                
                Yes, true. The reader is using Poppler which has the "Investigate better (that is, normal) text selection" as a ToDo now for a long time: cgit.freedesktop.org/poppler/poppler/tree/TODO
                
                
– Marcus
                

                May 9, 2016 at 12:49
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I have got a workaround to this problem, but it is too localized. Using okular for reading a pdf file and then annotate by pressing F6 to bring Highlighting toolbar.


After annotating, you can save the file as document archive, which preserve the annotation. From File -> Export as -> Document Archive. 


Note This file can only be opened by Okular.


Installing Okular: To install okular, issue this command in terminal :

sudo apt-get install okular
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                You can just do Save As now in Ubuntu 13.04 :)
                
                
– shaneonabike
                

                Sep 20, 2014 at 20:44
            

        

    
	
        
            
            

        

        
            
                
                It was an answer to another specific question merged here. I now use Evince and/or Foxit Reader.
                
                
– Anwar
                

                Aug 24, 2016 at 11:29
            

        

    
	
        
            
            

        

        
            
                
                The okalur developer should enabeble Hightlighting toolbar by default. Struggling for days and your comment did save me. Thank you
                
                
– Vu Gia Truong
                

                Jul 24, 2018 at 1:12
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Jarnal is a good software that allows you to highlight
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I've tested PDF X-Change viewer and I experienced the same white space problem while scrolling. I'm currently using Foxit Reader 4.3 which works really flawlessly. Foxit 5 crashes with wine 1.3 but works fine with wine 1.4 and 1.5. The only minor bug is that when you add a text annotation, it will ask you if you want to download the dictionary. You simple click cancel and keep working. It will keep asking you just once every time you open Foxit. 


I managed to make Foxit reader 4 my default pdf viewer but can open files by double clicking a pdf file only if Foxit is not open. With Foxit 5 this issue is solved too. See this thread: How do I set a wine program (ex. Foxit Reader for Windows) as the default program?


Hope the pdf annotation feature in evince improves to avoid using wine.
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The latest version of Ubuntu's default PDF viewer Evince has a built-in highlighter. It is very efficient. And unlike other softwares, the highlighted text is also detected when we open it using other softwares like Adobe PDF Viewer. The version number is 3.17.4 and you can download it using the link below:


https://github.com/GNOME/evince/releases


Please note that you have to first remove the old version of Evince before you install the new one. Also, the program crashed few times on my first day of install but it is totally fine for a month now. 


~Cheers~
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I use an old version of Foxit Reader (the latest 4.x version from oldapps.com), and it works very well under Wine. 


At the moment, there is no good native highlighting solution!
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PDF Studio is, probably, the best solution. It is not free, but you can install it using the Ubuntu Software Center.
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LibreOffice Draw works reasonably well for PDFs. It can not only annotate but do all the features of Draw such as drawing lines, shapes, etc. It saves as its own file format .odg but can export as PDF. 
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I think that Xournal is the tool you're looking for.
What you should do is exporting in PDF, and the changes will be saved in pdf.
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Maybe xournal (app to add annotations to pdf's files)


Click to install xournal


And okular save the hightlighting separetly then if you want to save the hightlighting you have to save the pdf like new file to save the hightlighting.

    

    
        
            
            
                




    

        
            Share
        



                    
                        Improve this answer
                    


                
                    
                        Follow
                    
                







    

    



            



            
                
    
        
            answered May 23, 2012 at 17:18
        

        
    

    
        

    

    
        KesymaruKesymaru
        
            34111 silver badge88 bronze badges
        

    





            

        

        
    
    

    






            5 
    
        
            	
        
            
            

        

        
            
                
                I have tried saving as new file. Did you try that ?
                
                
– Anwar
                

                May 23, 2012 at 17:31
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                This saves the highlighting to be part of the PDF in a way that can't be edited in other PDF editors, if I am correct.
                
                
– MarkovCh1
                

                May 23, 2012 at 17:31
            

        

    
	
        
            
            

        

        
            
                
                I really like Xournal but when you export Xournal annotations as PDF it saves an image of every page with the annotation. So when you send that pdf to someone else, they will not be able to search through it. Other than this main limitation, Xournal is pretty cool.
                
                
– Aras
                

                Aug 5, 2012 at 7:55
            

        

    
	
        
            
            

        

        
            
                
                I just used Xournal, and the file were saved as a searchable PDF. Excellent.
                
                
– Erel Segal-Halevi
                

                Mar 20, 2013 at 10:29
            

        

    
	
        
            
            

        

        
            
                
                This is duplicate of the other answer
                
                
– Archisman Panigrahi
                

                Dec 5, 2020 at 15:08
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I had the same question but unfortunately I didn't arrive to any satisfactory answer, being okular the closest one (but as you say, it does not save the changes in the same file, which is a problem). 


I finally decided to use "PDF-Xchange Viewer": that piece of program makes exactly what I wanted to do and does it well, but it has two problems: it is free but not opensource and there's no linux version, although it can be used in ubuntu via wine. I wish there were better ways to annotate PDFs and so on. 


Maybe you could open an issue at okular developers so hopefully they can implement that feature in the nearly future.
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You should also try PDF Buddy, an online PDF editor that supports highlighting, annotation, and other common editing features. It's a fast and easy solution that works in any modern browser.


(Full disclosure: I'm a co-founder of PDF Buddy) 
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                Is it open source?
                
                
– Archisman Panigrahi
                

                Nov 10, 2020 at 13:46
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I got good results when annotating and editing PDFs online using PDFescape. There's a limitation on file size (10MB) and number of pages (100) though.
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